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Getting Started

B About Screen Receiver
» Screen Receiver provides the following functions.
- Display of calculator screen images on a computer connected via a USB cable
- Real-time display of calculation operation results
- Zooming of display contents
- Capture of screen contents
- Copy and paste of captured screen images to other applications
- Storage of captured screen images as image files
- Printing of captured screen images

B Using This Manual

* The procedures in this manual assume that you are already familiar with the following standard
computer operations.

* Menu operations using the mouse, including: clicking, double-clicking, dragging, etc.
- Text input using the keyboard
- Icon operations, general window operations, etc.

- If you are not familiar with these types of operations, refer to the user documentation for your
computer.

* The explanations in this manual cover both Windows and Mac OS. Most of the screen shots are
from Windows XP, but operational procedures are virtually identical for both Windows and Mac
OS.

* Note that the actual appearance of the screen that appears when using this software depends
on your computer system setup and on the operating system you are using.

» Screen shots shown in this User’s Guide are intended for illustrative purposes only. The actual
text and values that appear on display may differ from the examples shown in this User’s Guide.

* This manual explains Screen Receiver operations using a CASIO fx-CG Series calculator.
Screen Receiver operations are identical when using a ClassPad 330 PLUS/ClassPad II.
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H System Requirements

Windows

Operating Systems:
Windows XP Home Edition, Windows XP Professional (32-bit), Windows Vista® (32-
bit), Windows 7 (32-bit/64-bit), Windows 8 (32-bit/64-bit)
Your hardware configuration needs higher than functionalities that operating system
recommends.

Computer:  Computer with one of the Windows operating systems pre-installed (Excluding
computers with an upgraded operating system and self-built computers.)

Disk Space: 100MB for installation and uninstall

Note: Actual requirements and product functionality may vary based on your system
configuration and operating system.

Other: USB port for direct connection. Do not connect via a USB hub.
Video adapter and display must support resolution of XGA (1024x768) or higher, 16
bit or higher system color.
Internet Explorer® 6.0 or later.
CD-ROM drive.
Adobe® Reader® 6.0 or later.

Mac OS

Operating Systems:
Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, Mac OS X 10.8
Your hardware configuration needs higher than functionalities that operating system
recommends.

Computer: Intel® Processer
Computer with one of the Macintosh operating systems pre-installed (Excluding
computers with an upgraded operating system.)

Disk Space: 100MB for installation and uninstall

Note: Actual requirements and product functionality may vary based on your system
configuration and operating system.

Other: USB port for direct connection. Do not connect via a USB hub.
Video adapter and display must support resolution of XGA (1024x768) or higher.
For Retina display, use of the Low Resolution mode is recommended.
Safari 3.0 or later.
CD-ROM drive.

Note

* Windows, Windows Vista and Internet Explorer are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

* Mac, Mac OS, Macintosh, Safari and Retina are registered trademarks or trademarks of Apple
Inc. in the United States and/or other countries.

* Intel is a registered trademark or trademark of Intel Corporation in the United States and/or
other countries.

e Adobe and Reader are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

e Company and product names used herein are trademarks of their respective owners.

* Note that trademark ™ and registered trademark © are not used within the text of this user’s
guide.
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1. Installing and Uninstalling Screen Receiver

This section explains how to install and uninstall Screen Receiver.

To install Screen Receiver

Note
* Do not install Screen Receiver into a folder that is used by other software.

1. Place the CD-ROM into your computer’s CD-ROM drive.
* After a short while, the Utility CD screen will appear on the display.

2. Click “Screen Receiver”.
3. Click “Install”. Perform operations as instructed by the text that appears on the screen.

4. The dialog box shown below will appear when installation is complete.

i Screen Receiver - InstallShield Wizard

InstallShield Wizard Completed

) The Installshield Wizard has successfully installed Screen
| Receiver, Click Finish to exit the wizard.

E|n|sh Cancel

5. Click the [Finish] button.
* This completes installation.

Note
* Installing the software will put a “Screen Receiver” shortcut icon on your desktop.

E-4



To uninstall Screen Receiver
Windows

1. Display the Windows Control Panel.
2. Click [Add/Remove Program].
3. On the list of applications that appears, select “Screen Receiver”.

4. Click the [Add/Remove] button.
* This will display the program maintenance wizard.

5. Click the [Yes] button.
* This completes the uninstall operation.

Mac OS

1. Move Screen Receiver(.app) to the Trash folder.

2. From the menu, select [Finder] and then [Empty Trash].

To start up Screen Receiver

1. Windows: On your computer’s desktop, double-click the “Screen Receiver” icon.
Mac OS: In the “Applications” - “CASIO” folder, double-click “Screen Receiver”.

* Windows: You could also start up the application by clicking [Start] - [Program] - [CASIO] -
[Screen Receiver] - [Screen Receiver].

Windows Mac OS

@ T

.

i dald

SCreen
| ===

ECEIVEF Receiver

Screen
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2. Screen Configuration

The following shows the Screen Receiver screen.

Bl When connected to a CASIO fx-CG Series calculator

Windows
Menu Bar—L Screen Receiver - DispCap3

kFile Edit ScreenReceive View ‘Window Tools Help
Toolbar—f atad S@ &2 @R “ R [« |
I@ [EXE]:Show coordinates =|DispCap1
Y1=x2 ¥
B [ DispCap2
E DispCap3
" Artn.s.0.81) B ¢ Bl [EXE]:Show coordinates
: [¥
0
Calculator screen
" Grn.8.0.81)
X=0.9 ¥=0.81 :
¥=0.81
StatUS Bar— Ready C:iDocuments and SettindsiadministratoriMy Documents Bmp
/ Captured data windows
Data area
Mac OS
Menu Bar— ® Screen Receiver File Edit Screen Receive View Window Help

Toolbar
£ DisnCanl
oNaNal DisnlCan2
v @00 DispCap3
ce = @ QA
[EXE]:Show coordinates
110.3,0.81) ¥
Calculator screen il i toE s
10.9,0.81)
StatUS Bar fUsers /fx/Pictures/CASIO/Screen Receiver/

Captured data windows

Data area



B When connected to ClassPad 330 PLUS

Windows

Screen Receiver — DispCap3
File Edit Screen Receive Miew Window Toolz Help

[Shestl
®zl=sin(x)
0z2:0

s

Ci\Documents and SettingsiAdministratorify Documents

Mac OS

@0 Screen Receiver File Edit Screen Receive

Screen Receiver

: ©)_DispCap2
N Edit Zoom Analysis + ® O O DispCap3

<] -
I

~ _Edit Zoom Analysic ¢ Ddj

Rad_Real

JUsers [fx/Pictures/CASIO/Screen Receiver/
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B When connected to ClassPad 11

Windows

Screen Receiver - DispCap3

File Edit 3ScreenReceive Yiew MWindow Tools Help

|atad 38 & @8 A& [

# Edit Zoom Analysis ¢ DispCap O
BEEFEEREE G K o s
sheet1 [Sheet2 [Sheet3|Sheet4 [Sheet5 | Dispap .
Myi=y2 — % # Edit Zoom Analysis ¢
W i | Eopcg = | i xx
[Jy2:0 gI“]IEEII@lIIB’_I’
[y3:0 | [sheet1 [sheet2|sheet3 [Sheet4 [Sheet5 |
Dy4:|:| m Eyl:xz [ ]
L ly5:0 I v2:o
Cy6:0 N Cys:o
.70
y=—2ex—1 a¥ o vt
y=2x=-1 3l : [J¥5:0
2 L} I¥6:0
I (._1’.1)5“1-.“5(1’.1). o) oix Clon =
55152 T 234886 7 ye—Dex—1 AL | 4l¥ |
(0,-13 y=2rx=—1 3
_3_ - j |
=0 Sl Intersection cun X Aan T
| B 755 A& 3
Rad Real T ] i
¥c=0
A
Rad  Real
Ready CiDocuments and SettingsifxiMy DocumentsiCASIONScreen Receiver
Mac OS
Screen Receiver Fi Edi ive View Window
8008 Screen Receiver =
i ! I — 1 -
Stk B ) A e 3xi I — Micnland
I QNSNS I'Jiq;(’ag? i
=) ispCap
X .
E T
& Edit Zoom Analysis e
Sheet1 [Sheet2[Sheet3 [Sheetd [Sheet5 | [: T =,
1=.2 e i -
Blv1=x - [Sheet1 [Sheet2 [Sheet3 [Shest4 [Sheat5 |
[¥2:0 .
Myi1=y2 (—1
[Ox3:0 I
Cly4:0 §/Ev#u
[ ]y5:0 H|[]¥3:0
[lvé:0 §/0va:0
[w7:01 L[ Jy5:0
yff—Q»-x—l ¥ H|(dve:0
¥T2LX—1 a Hlwz-0
r 2 Hy=—2+x—1 a¥
oo Aan x iy T2ex=l 3
655432 123456 7 M 2
0,-1» - LA A %
) g T2 345687
- Intersection i ah
xc=0 —Aryo3gl |
B L 8 Intersection
Rad  Real o xe=0 “ifyesol i
] EE
fUsers ffx fPictures/CASIO/Screen Receiver/ Hﬂd HEaI il m
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Menu Bar

* This section explains the Screen Receiver menu bar.

e If a menu command can also be executed by clicking a toolbar button, the applicable toolbar

button is also provided.

M File Menu

Cloze

Capture Screen

Save L (f L
Save Az

Erint Ctr+P
Print Prewigw
Print Setup...

Exit

Toolbar

Menu Button

Description

Close

Closes the active captured data window.

Capture Screen

Captures the calculator screen. Each capture adds a capture
screen to the captured data area.

Saves the contents of the active data capture window,

Save overwriting the existing data.

Saves the contents of the active data capture window under
Save As )

a new file name.
Print Prints the contents of the active captured data window.

Print Preview™!

Lh O

Displays a preview of the print image.

Print Setup

Displays the print setup dialog box.

Exit*?

Exits Screen Receiver.

*I' Windows only

*2 Mac OS: On the [Screen Receiver] menu, selected [Quit Screen Receiver].
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B Edit Menu

Copy  Ctrl+G

Menu

Toolbar
Button

Description

Copy

Copies the contents of the active captured data window to
the clipboard.

Hl Screen Receive Menu

acreen B
Start Ctrl+T
Stop  Ctrl+0
Toolbar -
Menu Button Description

&

Establishes a connection between Screen Receiver and

Start calculator and displays the calculator screen contents.
Terminates the connection between Screen Receiver and the
Stop a
calculator.
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Bl View Menu

.II_II- | [=10l]

Beduce Ctr+R
Expand Ctr+E

Zoom w1

» Toolber Y i ;
» otatus Bar
Menu Submenu Toolbar Description
Button
Reduces the size of contents of the active captured
Reduce & .
data window.
Expands the size of the contents of the active
Expand E:ﬁ .
captured data window.
Displays the contents of the active captured data
Zoom x 1 . o .
window in its actual size.
Displays the contents of the active captured data
X 2 . . '
window as 2X its actual size.
Displays the contents of the active captured data
x 3 . . :
window as 3X its actual size.
Toolbar Toggles display of the toolbar on and off.
Status Bar Toggles display of the status bar on and off.




Hl Window Menu

w | ] d (1]

Cascade
Tile Horizantal
Tile Wertical
Arrange [cons
Cloze all
1 DigpCapl ~ ]
2 Disptapd — Captured data
v 3 DizpCap3d ||
Menu Description
Cascade Stacks captured data windows.
Tile Horizontal*! Lines up captured data windows horizontally.
Tile Vertical* Lines up captured data windows vertically.
Arrange lcons Displays captured data windows as icons.
Close All Closes the all captured data windows.
(Captured data) Shows the names of the displayed captured data.

*' Windows only

Hl Tools Menu (Windows only)

Tools

Dptions...

Menu Description

Options™! Displays a dialog box for configuring optional settings.

*'Mac OS: On the [Screen Receiver] menu, selected [Preferences...].
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H Help Menu

Marnual
License
About  F1

Menu

Description

Manual Displays the Screen Receiver User’s Guide.
License Displays the end user license agreement.
About™*! Displays version information.

*Mac OS: On the [Screen Receiver] menu, selected [About Screen Receiver].

Status Bar

|C-:|:-ies the selected data to the dipborad.

C:\Documnents and SettingstAdministratoriMy Documents

@

@

(D Help text is displayed here (Windows only).
@ Folder where captured data is stored
@ File name extension of captured data files
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3. Using Screen Receiver

3-1 Establishing a Connection between Screen Receiver
and a Calcualtor

Important!

* Do not connect the calculator to the computer before starting up Screen Receiver. Start up
Screen Receiver first.

1. start up Screen Receiver.

2. Use the USB cable that comes with the calculator to connect it to your computer.
* This will display the dialog box shown below.

)
Select Connection Mode
1. | USE Flash ]
Connection Mode 2. | Screen Receiver |
USB Flash [F11] 3. [Screen ReceivertxFa |
ScreenRecv :[F2] | ——— |
ScreenR (XP) : [F3] . e o
Projector :[F4] 5. | Cancel |
fx-CG Series ClassPad 330 PLUS

ClassPad II

3. tx-CG Series:
For Windows Vista, Windows 7, Windows 8 user: press (F2).
For Windows XP user: press (F3].
For Mac OS user: press (F2).

ClassPad 330 PLUS/ClassPad II:

For Windows Vista, Windows 7, Windows 8 user: tap [Screen Receiver], or press the (2) key.

For Windows XP user: tap [Screen Receiver(XP)], or press the (3) key.
For Mac OS user: tap [Screen Receiver], or press the (2) key.

* This will display the dialog box shown below.

E  [ineRadforni [eal
G .

Configure
X ScregnReceiver
Y settings. I:c-nf_igur'e ScreenReceiver
Y Press: [EXIT] settings.
Yo :
(SELECT] RENA13 T RIXW MODIF Y] DRAW]

fx-CG Series ClassPad 330 PLUS

ClassPad I1
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e USB Connection Precautions

A USB connection between the calculator and a computer may be terminated automatically
if the computer enters a power save mode, sleep mode, or any other standby state. If this
happens, disconnect and then reconnect the USB cable.

e Windows XP Users

If this is the first time you are connecting the calculator to your computer, use the following
procedure to install the USB driver.

3-1. Connecting the calculator to a computer running Windows XP causes the screen shown
below to appear on your computer display.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helpz you install software for:

CESGS02 USB

Found New Hardware Wizard - _ . .
f\-) If your hardware came with an installation CD
“4E2 or Hoppy disk. insert it now.

‘Welcome to the Found New
Hardware Wizard

| e—-
Select “No, not
this time”.

‘what do you want the wizard to do?

Can Windows connect to Windows Update to search for
soltrare?

O Install fram a list ar zpecific location (Advanced)

Click Mest to continue.

3 Mest » ][ Cancel

3-2. Select “Install the software automatically (Recommended)” and then click [Next].

Hardware Installation

' "_l., The zoftware you are inztalling for this hardware:
L
CESGROZ LISE

haz not pazzed Windows Logo testing to verify itz compatibility
with “indowes =P, [Tell me why this testing iz important, |

Continuing your installation of this software may impair
or desztabilize the comect operation of your system
either immmediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
pazzed Windows Logo testing.

Continue Aryay ] EéTDPInstallatiun |
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3-3. Though a message appears to let you know that the software has not passed the
“Windows Logo Test”, there is no need for concern. Simply click [Continue Anyway] and
proceed with installation.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

% CESGR0ZUSE

Click Finizh ta clage the wizard.

Cancel

3-4. Click [Finish].

4. ix-CG Series: Press (ExT).
ClassPad 330 PLUS/ClassPad II: Tap [OK].

* This automatically establishes a connection between Screen Receiver and the calculator,
and displays the calculator screen on the Screen Receiver window. Wait until the calculator
screen appears on the Screen Receiver window before performing any calculator operation.

Windows Mac OS
= 806 Screen Receiver

Al 2888

Calculator screen Calculator screen

5. Perform the operations you want on the calculator.

* The calculator screen displayed by Screen Receiver will change in real time as you perform
operations on the calculator.

6. To terminate the connection between Screen Receiver and calculator, click a .

7. Disconnect the USB cable from the computer and calculator.

Note

¢ |f the connection between Screen Receiver and the calculator terminates for some reason, click
E to reconnect.
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3-2 Calculation Operation Precaution

* The way figures are drawn and the cursor moves on the Screen Receiver screen may not
exactly match what appears on the calculator screen.

* Attention Windows Vista, Windows 7 and Windows 8 users
The calculator does not support the operations below while there is a connection between the
calculator and Screen Receiver.
- File delete
- Folder create or rename
- Backup
- Optimization
- Reset operations (Add-In, Storage Memory, Add-In&Storage, Main&Storage, Initialize All,
Language File)

Screen Receiver will not display the calculator screen while the calculator is performing a file
save operation. The calculator screen will appear after the file save is complete.

3-3 Capturing the Calculator Screen
1. Perform the required operation on the calculator to display the screen you want to capture.

2. Click 8-
* This displays the captured data.

Screen Receiver, - DispCap4.

Eile Edit ScreenReceive Wiew Window Tools Help

BEOH &8 2 TR AR v v
|E_"—-m [Eeal [ DispCap4 \ZHE”Z\

Graph Fune :Y=
[—]1
Y3f [—]1 = —
¥g§ % : [—] Captured data

[—1

[—] —
ELEG DELETE] TYPE ] TOOL 2ol -32 _—

aNERd[DELETE] TYPE | TOOL JIRelullai| 1]

Feeady CriDocuments and Settings\Administrator|My Documents Bmp

3. Repeat steps 1 and 2 to capture other screens, if you want.

Note

* You can put a frame around the captured data by clicking "'|_—| Each click toggles between
framed and unframed data. For more information, see “4-2 Capture Settings” (page E-25).
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3-4 Making a Captured Data Window Active
Clicking a captured data window makes it the active window.

Screen Receiver - DispCap3

File Edit ScreenReceive View window Tools Help

miad &3 TR AR [a v
I@ [EXE]:Show coordinates & DispCap

V=22 - ==—"-
* y ® = DispCap2
@ DispCap3 =
(1
(0.9.0.81) - E
OL
|1¥=0.9 =0.81

Active captured data

Ready Ci\Documents and SettingsiAdministratority Document s Bmp -

Note
* Only one captured data window can be active at any time.

* To zoom, copy, save, or print the contents of a captured data window, you first must make it the
active window.

3-5 Copying Captured Data Window Contents to the
Clipboard

1. Make the captured data window that contains the data you want to copy the active window.

2. Click to copy the captured data to the clipboard.

3-6 Saving Captured Data

Make the window that contains the captured data you want to save the active window, and then
click i -

Note

» Saved captured data is automatically assigned a file name of the following format: DispCapXX.
XXX.

* The file format (bmp, jpg, png) and storage folder are in accordance with the settings described
under “4-1 File Save Settings” (page E-25).

* You can use the [Save As] command on the [File] menu to save the file under a different name.
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3-7 Auto File Save

Attempting to exit Screen Receiver while there is unsaved captured data will cause the dialog box

shown below to appear.

! j File will be saved automatically. Ck?

File: save format

Sitmap Files (*.bmp)

®_-E0verwrite Confirmation [ Yes(¥) ] ’ Mol ] ’ Cancel ]

(1 Specifies the file format for the saved file. You can select bmp, jpg, or png.

@ If there is already a file with the same name that you specify, this option specifies whether or
not the older version should be overwritten with the new one.

3-8 Resizing a Screen Image

To resize the calculator screen

Right-click the calculator screen. Click [Zoom] on the shortcut menu that appears and then select
a zoom factor.

i

Screen Receiver

File Edit Screen Receive iew findow  Toole  Help

@ %1 w
MAIN'MENU

l.Z ‘3 “-4

eActivity Spreﬁéheet
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To resize the calculator screen when capturing it

On the toolbar, click the down arrow button of the zoom box. On the menu that appears, select a
zoom factor.

[ Screen Receiver
File Edit Screen Receive Wiew Window Toolz  Help

Zoom menu

To resize captured data

Make the window that contains the captured data you want to resize the active window, and then

click ('R or ﬁ You can select one of three sizes.

You also can resize by selecting a zoom factor with the [Zoom] command on the [View] menu.
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3-9 Using a Floating Calculator Screen (Windows only)

You can display the calculator screen in its own window that is separate from the Screen
Receiver window.

To make the calculator screen a floating screen
1. Double-click the calculator screen.

2. Drag the calculator screen to the location you want, either inside or outside of the Screen
Receiver window.

Display
[l [EXE]:Show coordinates
V1=x2

To return a floating calculator screen to the Screen Receiver window
- Double-click the floating calculator screen.

- Drag the calculator screen back to the left side of the Screen Receiver window.

Important!

* You can return a floating calculator screen only to the left side of the Screen Receiver window.
Dragging top, bottom, or right side of the main window will not work.
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3-10 Printing

* You can print the contents of a captured data window, if you want.

1. Make the captured data window that contains the data you want to print the active window.

2. Click 4. This will display the Print dialog box.

Printer

Mame: ' - V| [ Properhies... ]

Status: Ready

Type: Y T

‘Where:  LPTT:

Comment; [ Print ta file
Frint range Copies

= Al Murnber of copies: 1 g

] wf ]
CRH M
[

oK l [ Cancel

3. Click [OK] to start printing.

Important!

* Only the contents of the currently active captured data window can be printed. You cannot print
the contents of multiple captured data windows with a single print operation.

* Images are printed in accordance with width setting of the paper size selected on the Print
dialog box.
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M Print Preview (Windows only)
* Click @ to display the print preview window.
@ @ © @

-
Screen Recewer - DigpCGapl

Mext Page | Frew Page | TwoFage

MAINVENU

(@ Displays the Print dialog box.
@ Enlarges the preview image.
@ Reduces the size of the preview image.
@ Closes the print preview window image.

M Print Setup Dialog Box
* Selecting [Print Setup] on the [File] menu displays the Print Setup dialog box.

Print Setup

Pririter

Neme: | | [ Fuopsie:.
Status: Feady

Type: bl b apondbe . |

Where:  LPTI:

Comment:

Paper Orientation

Size: | Letter w | (%) Partrait
Source; |.-’-'«ut0matica|l_l,l Select V| () Landscape
e
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3-11 Shortcut Menu

On the calculator screen or captured data window, right-clicking with your mouse (Windows) or
performing a control+click (Mac OS) will cause the shortcut menu shown below to appear.

Screen Receiver

DizpGapl L =14
File Edit Screen Receive Miew Window Tools  Help EI[EWEl
@ MAIN MENU

" Gopy Ctrs “_ 4

Save Ctrl+5 ﬂ.(

Save fz. Sp readsheet

Print Ctri+P &

Print Prewiemw

Print Setup.. Recursion

Calculator screen Captured data
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4. Tool Options Dialog Box

4-1 File Save Settings

Tool Options E|
File |Capture
File: save format
Select a file Format,
@ @ Emp: O Ipg OPng
Daka folder
Specify folder to store data,
@ I Ci\Documents and Settings\administratoriMy Documents | [ ]
[o]'4 _J [ Cancel ]
(1 File name extension of captured data files
@ Storage folder
4-2 Capture Settings
Tool Options E|
File Capture |
Frame
Specify frame on/off for screen capture.
@ O C © © ®
ol4 ] [ Cancel
(1 Specifies unframed captured screen images
@ Specifies framed captured screen images, and frame thickness.
Captured data example
El El
Graph Fune :Y= Graph Func :VY=
Y 1Ex2 [—] Y1Ex? [—]
Y2: [—1 Y2:
Y3: [—1 Y3:
Y4: [—1] Y4:
Y5: [—1 Y5:
Y6: [—]1] Y6: [—1]
SaIEAN| DELETE] TYPE ] TOOL JrEWiilad || Sa0Eell| DELETE] TYPE J TOOL JWai |

Unframed
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5. Error Message Table

Message

Description

Required Action

A problem occurred while
writing file <file name>.

The disk being written to may
be damaged or may not exist.
Check the disk and try again.

A problem occurred while
writing to a disk.

Check the disk for data
corruption and confirm that
the disk exists. Then try
again.

A problem occurred while
launching the manual (***.pdf)
viewer.

Download the viewer from the
site below and reinstall it.
http://get.adobe.com/reader/
otherversions/

A problem occurred during
manual viewer startup.

Download and install a new
viewer from
http://get.adobe.com/reader/
otherversions/.

The path and/or filename
exceeds the maximum length
allowed by your Windows*
operating system.

The number of letters in
the path or file name you
specified exceeds the
allowable limit.

Shorten the specified path or
file name.

A connection could not be
established.

Either the calculator is not
connected or the connected
calculator is not in the Screen
Receiver Mode.

Correct the problem and try
again.

For details, select the
following on the menu bar:
Help - Manual, or refer to the
Screen Receiver user’s guide.

You started a data
communication operation
while the USB cable was not
connected.

Check for proper connection
of the calculator to the
computer. Then try again.
See “3. Using Screen
Receiver” for details.

A problem occurred during
communication.

Disconnect the USB cable,
check the setup of the
calculator, and try again.

For details, select the
following on the menu bar:
Help - Manual, or refer to the
Screen Receiver user’s guide.

Some problem occurred
during data communication.

Disconnect the USB cable
and check the setup of the
calculation. Then try again.
See “3. Using Screen
Receiver” for details.
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Message

Description

Required Action

The image could not be sent

from the calculator.

(1) Try pressing a key on the
calculator.

(2) Check to make sure that
the calculator is in the
Screen Receiver Mode.

If the screen is not sent after

you perform the above steps,

disconnect the USB cable
and check the calculator
setup. Next, reconnect and
try again.

For details, select the

following on the menu bar:

Help - Manual, or refer to the

Screen Receiver user’s guide.

The calculator screen image
cannot be sent for some
reason.

Follow the steps that are
shown on the display and try
again.

See “3. Using Screen
Receiver” for details.

The connection has been
broken for some reason and
is being restored.

If data communication does
not resume after some

time, perform the operation
described below.

Try pressing a key on the
calculator. If the screen is
not sent after you perform
the above steps, disconnect
the USB cable and check
the calculator setup. Next,
reconnect and try again.
For details, select the
following on the menu bar:
Help - Manual, or refer to the

Screen Receiver user’s guide.

Follow the steps that are
shown on the display and try
again.

The application is already
running.

Another user may already be
using the application.

Another user is running
Screen Receiver.

Wait until the other user shuts
down Screen Receiver.

*Mac OS: Macintosh
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